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What It Does

You can easily export information from DDMS reports
into other applications, such as Microsoft® Excel or Ac-
cess. We'll show you two ways to export information.
We'll also explain how to import this information into
Excel, since this is the application most users want to im-
port information into.

How to Do It

Exporting files from a DDMS Windows system requires two
steps: exporting the file from your Windows system, and
importing into your application. We’ll describe two meth-
ods for exporting files (as text files and as database files).
Then, we’ll explain how to import both file types into Excel.

Exporting Information as Text Files

To export information from your Windows system as a
text file, you perform three basic steps:

* Setting up a generic file printer
¢ Adding the file printer to your TBL server
¢ Creating the file.
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Setting up a Generic File Printer
1 Go to the Windows server.

Click the Start button, then click Settings and
Printers.

In the Printers window, double-click Add Printer.
In the Add Printer Wizard, click Next.

Select Local Printer. Uncheck Automatically detect
and install my plug and play printer. Then click Next.

You can set up file printers in two ways:

¢ Use the File port, which lets you specify the path
and file name each time you print, so you can cre-
ate several text files before you import them. To
set up this type of file printer, go to Step 5.

* Add a new port, which lets you predetermine the
path and file name of the printer text file. How-
ever, you must import each text file before print-
ing the next, or the new data will overwrite the
previous data. To set up this type of file printer,
go to Step 6.

5 To set up a file printer with the File port:
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¢ At Use the following port, scroll down and select the Default Printer: click No. Then click Next.
—hen click Next. See the flgre below. ¢ Click Do Not Share this printer, and click Next.
Select the: Printer Port ¢ At Would You Like to Print a Test Page, click No,
Computses conmuricsle wath pinters biough parts. .
and click Next.
T LS Lo, (TR BT e e T e * At Completing the Add Printer Wizard, click Finish.
o Lzl * Go to Adding the File Printer to your TBL Server.
Ponl | Doz iiption | Pinlar 2]
CoM1 Fenad P N 6 To set up a file printer by adding a new port:
COM3: Serial Port
COM4 Senl Pl ¢ In the Select the Printer Port window, click Cre-
P AT M Sleevdmrd TR Pt P | ol 677 St B B 2 ate a New Port.
Mol Mo computen: Lza ba LURT 1 port bo commiricala sath & kacal pantan
€ Creste a new part : = ¢ In the Type list, click Local Port, then click Next.
- ¢ In the Port Name window, specify the path for
B s —_ the reports you'll be exporting, followed‘by the
file name FILE.TXT. Click OK. (See the figure on

h .
¢ In the Manufacturers list, click Generic. the next page.)
If you want the files to be accessible from a client

machine, make sure that the folder you specify is a
shared folder. (If you need help creating a shared
¢ If you see a Generic/Text Only window now, folder, contact your network administrator.)

click Keep Existing Driver, and then click Next.

¢ In the Printers list, which is on the right, click Ge-
neric/Text Only, and then click Next.

Suppose the DDMS folder on your server is

¢ At Printer Name, keep the default name or shared. You would specify a path of
specify another name. c:\ddms\file.txt, as shown on the next page.
* The same window also displays Do You Want ¢ In the Add Printer Wizard window, click Next.

Windows-based Programs to Use This Printer as
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Add Printer Wizard

Sebact the Printer Port
Computsrs conmuricsle wath pinters biough ports.

Select lhe poil you sent pour pinder to use. I e pol & rot isted, pou can ciests a
ey porl,

T L e Floiing pacil:

Bl | Doz ciption | Pinlar | =
LPT1: Frirler Fait Canon BIC-2000, Aciobst FD...
LPT2 Pricker Pant —
LPTZ Friker Foit

COk1 Senal Foil

Lok 2: Sl Fol

ke Smral Fral ﬂ

Mol Mo computen: Lza ba LURT 1 port bo commiricala sath & kacal pantan
1% Creste & e port
Time: |Lozal ot =l

Part Name 3

Erler = pail name: : [
|CADDMEAFILE TT Cancsd |

¢ In the Manufacturers list, click Generic.

¢ In the Printers list, which is on the right, click Ge-
neric/Text Only, and then click Next.

* At Keep Existing Driver, click Next.

¢ At Printer Name, keep the default name or
specify another name.

* The same window also displays Do You Want
Windows-based Programs to Use This Printer as
the Default Printer: click No. Then click Next.

¢ Click Do Not Share this printer, and click Next.
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* At Would You Like to Print a Test Page, click No,
and click Next.

e At Completing the Add Printer Wizard, click Finish.

Adding the File Printer to your TBL Server

7

10

11

From the Windows server’s desktop, double-click
the TBL Configuration icon.

In the TBL Config window, click Printer Defini-
tions to highlight it.

With Printer Definitions highlighted, right-click to
display Add New, and click it.

In the Printer Definition window, click next to the
P in the TBL Name field, and specify the number
you want to assign this printer.

Specify a unique number. If your system already has
printers P1-P4, for example, make the file printer
P5. To do this, type 5 after the P in the TBL Name

field. T ]
In the Network list, ThHara[FS
click the printer you Newah[GENERIE 1 4T oLy =

added earlier. (If you
accepted the default o =l

name, it’s Generic/ Dsickption] GELE RIC FILE FRINTER

Text Only, as shown

here.) [ o | Cancel |
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12
13

14

Creating the File

15

16
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In the Emulation list, click PR. Make sure you add an extension of .txt, as shown

At Description, enter a name of your choice, such in the figure.

as FILE PRINTER, and click OK. Note: The default path for these files is

Before you can create a file, you must close TBL C:AWinnt\system32. If you want to use this

Server, and then start it again. path, type a file name, such as report.txt, with-
out a path.

This is a dedicated function. Make sure that all P

other users have logged off the system before you To import your file, go to Importing a Text File

close TBL Server. into Excel.

Exporting Information as Database Files

You can export information from your Windows system
as a database file, if the information you want can be gen-
erated from a Report Writer screen. (Report Writer
screens use selectors; examples are the (N) and (R)

If you added a new port, the system automatically  gcreens, but not the (NR) or (RR) screens.) To export in-

saves your information in file.txt, which is created  formation as a database file, follow these steps:
in the folder you specified in Step 6. To import

your file, go to Importing a Text File into Excel.

To export information, print a report as you usually
do, with one exception: specify the file printer. (Using
our previous example, where we defined P5 as the
file printer, you would specify P5 to export a report.)

17 Go to the screen where you normally print the re-
port. Print the report as you normally do, with one

If you used exception:

the file port, ) o ]

at Output ot Pl e [ ] At Prt, instead of specifying a printer, type S and
File Name, [OETOMERLETIHG T=T _ Lol | press TAB.

specify the tise_| 18 When you complete the last field in the screen, the
path where prompt Save Print to File appears.

you want the file saved, and a unique file name.
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Specify the file name the system will create, as
shown in the figure on this page. (You do not need
to specify the .dbf file extension.)
If you do not fill the field, press RETURN.

19 Complete the report request as you normally do.

The system will create a file from your report on
your work unit. It will have a .dbf extension.

Go to Importing a Database File into Excel.

As:45:00 (R) INVENTORY SELECTORS rev. (04/22/99) 03/31/00\
Number Report: R_CAT3 Selector: R-CAT3

1= * CLASSIC REPORTS * * * SELECT THE CLASSIC R SCREEN WITH #1

2 = BASIC INVENTORY SET-UP REPORT SORT: 1-ITEM #, 2-CO.  NO LIMITS

3 = ITEM CATALOG MASTER LISTING SORT: 1-ITEM #, 2-CO.  NO LIMITS

4 = ITEM ALIAS MASTER LISTING SORT: CUSTOMER NAME NO LIMITS

5 = ITEM CATALOG: 0/0, O/H, B/O SORT: 1-ITEM #, 2-CO.  NO LIMITS

6 = ITEM CATALOG: COST, PRICE, MARGIN  SORT: 1-ITEM #, 2-CO. NO LIMITS

7 = ITEM CATALOG: AVG, REPLACE, PRICE  SORT: 1-ITEM #, 2-CO. NO LIMITS

8 = ITEM PRODUCT LABELS W/LIST PRICE SORT: 1-ITEM #, 2-CO.  NO LIMITS

9 = ITEM PRODUCT LABELS W/BIN LOCATIONS SORT: 1-ITEM #, 2-CO. NO LIMITS

10 = ITEM SHELF LABELS SORT: 1-ITEM #, 2-CO.  NO LIMITS

11 = ITEM SHELF LABELS W/QUANTITY BREAKS SORT: 1-ITEM #, 2-CO.  NO LIMITS

12 = LOW STOCK WHOLESALER REPORT-MIN/MAX SORT: ITEM #,CO.,LIMIT: NEEDED ITEM

13 = LOW STOCK WHOLESALER REPORTS-CYCLE SORT: ITEM #,CO.,LIMIT: NEEDED ITEM

14 = INVENTORY EXTENDED DOLLARS SORT: 1-ITEM #, 2-CO.  NO LIMITS

15 = INVENTORY USAGE REPORT SORT: 1-ITEM #, 2-CO.  NO LIMITS

16 = CONTRACT REPORT SORT: 1-CONTRACT #, 2-ITEM #, 3-CO.

17 = CONTRACT REPORT FOR CUSTOMERS SORT: 1-CONTRACT #, 2-ITEM #, 3-CO.
Lowstock [ 1 weeks [10] ppt Pricing (MN wx PQ) [P] Up Qty [ 1 Up Rec[ ]

[6 ] Selector Totals Only :N LocC : Prt :S Copies : 1 Recs : Chain :

Importing a Text File into Excel

The following instructions explain how to bring a text file
containing information from your DDMS system into Ex-
cel. Importing text files into other Windows programs is
similar.

Note: These instructions are for Microsoft ® Excel 2000;
earlier versions of Excel will be very similar, if not
identical.

ISAVE PRINT TO FILE [ITEMLIST (NO PRINT;I

J
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20 Start Microsoft Excel.
21

22

From the File menu, click Open.

In the Open window, click the Files of Type list. Se-
lect Text Files from the list.

23
24

Navigate to the folder containing your text file.

Double-click on the file name to open the Text Im-
port Wizard.

25 At Original Data Type, click Fixed Width.

26 The bottom portion of the window shows what

each row of the file contains.

Determine the top row you want to include. DDMS
recommends selecting the row containing the col-
umn headings, since they’ll make it easier to define
column breaks, which you’ll do in the next step.
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27 In Start Import at Row, specify the top row to im- 29 In the next window, under Column Data Format,
port. In the figure, we're specifying row six, which click General, and then click Finish.

contains the column headings. 30 The program will import your data into a spread-

Click Next. sheet.
28 In the next window, adjust the column breaks:

¢ To add a column break, click to the right of the
column heading.

Importing a Database File into Excel

The following instructions explain how to bring a data-
base file containing information from your DDMS system
¢ To delete a column break, double-click it. into Excel. Importing database files into other Windows

. . rograms is similar.
* To move a column break, click and drag it. prog

When you finish adjusting the column breaks, click Note: These instructions are for Microsoft ® Excel 2000;
Next. earlier versions of Excel will be very similar, if not
identical.

I =t bnpatl W ieard - Sep | of £

31 Start Microsoft Excel.
32 From the File menu, click Open.

33 In the Open window, click the Files of Type list. Se-
lect dBase Files from the list.

34 Navigate to your DDMS work unit.
35 Double-click on the file name to open it in Excel.

36 The majority of the data will appear in a single col-
umn.
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37

38
39
40

41

Click on the column heading to select the entire
column. (Column headings are lettered: A, B, C,
and so forth.)

From the Data menu, click Text to Columns to
open the Convert Text to Columns Wizard win-
dow.

At Original Data Type, click Fixed Width.
Click Next.

In the next window, adjust the column breaks. To
do this, scroll down in the Data Preview window
until you see the report’s column headings, as
shown here. Then adjust the column breaks to each
heading has its own column. To do this, follow
these steps:

* To add a column break, click to the right of the
column heading.

¢ To delete a column break, double-click it.
* To move a column break, click and drag it.

When you finish adjusting the column breaks, click
Next.

In the next window, under Column Data Format,
click General, and then click Finish.
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42 At Do You Want to Replace the Contents of the

Destination Cells, click OK.

Note: The column that originally contained the ma-

jority of the data will retain its original width,
so at first it may be all that you see. Drag one of
its borders to make it a manageable width.
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